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ABSTRACT
This paper presents a recognizer for identifying references
to user interface components in online documentation. The
recognizer first extracts phrases matching a list of known
components, then employs a classifier to reject coincidental
matches. We describe why this seemingly straightforward
problem is challenging, then show how informal conventions
in documentation writing can be leveraged to perform classi-
fication. Using the features identified in this paper, our ap-
proach achieves an average F1 score of 0.81, and can cor-
rectly distinguish between actual command references and
coincidental matches in 93.7% of test cases.
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INTRODUCTION
The Internet contains a wealth of reference material, tutori-
als, and other documentation related to the use of interactive
systems. Written for the benefit of users, this documentation
is expressed in natural language. However, from the perspec-
tive of a software system, this documentation is opaque and
unactionable.

Recently, the CHI community has demonstrated interest in
the problem of automatic identification of references to user
interface components within online documentation. For ex-
ample, work by Ekstrand et al. demonstrates how a custom
search engine can extract commands mentioned in software
tutorials, so that those commands can be listed in the snippets
presented as part of enhanced search result pages [1]. Simi-
larly, query-feature graphs, by Fourney et al. , pair high-level
search query terms with the corresponding user interface el-
ements mentioned in collections of technical documentation
[3]. Also closely related is work by Lau et al. [4], which has
demonstrated the possibility of extracting action-target-value
triples from how-to instructions, with the goal of advancing
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machine-guided help systems. In their work, targets corre-
spond to interface widgets.

The problem of identifying user interface elements mentioned
within documentation is a domain-specific instance of named
entity recognition. In the context of technical documentation,
we are interested in the problem of extracting named entities
that refer to interface components, such as commands, menu
items, dialogs, settings, and tools within the interface.

In this paper, we introduce a named-entity recognizer for de-
tecting user interface elements mentioned within HTML doc-
uments. We call this specific problem named widget recog-
nition. In the following sections, we enumerate the specific
challenges for this problem, then discuss how certain infor-
mal conventions in tutorial writing can be leveraged to better
detect named entities in this context. From these conventions,
we derive a set of features and a general classification strategy
that leads to accurate recognition of user interface elements
referenced within text.

CHALLENGES AND RECOGNITION STRATEGIES
Web-based tutorials and documentation use natural language
to describe how to perform specific tasks with interactive ap-
plications. To be clear and unambiguous, authors typically
refer to user interface elements by their given, visible names
(i.e., captions or labels) [4, 3]. For example, an author may
write that the user should invoke the “Undo” command from
the “Edit” menu.

Given this practice, an obvious strategy to named widget
recognition is to simply search the documentation for strings
matching known widget labels. This tact requires a complete
list of widget captions, but numerous, reliable approaches ex-
ist for automatically enumerating and extracting the captions
of widgets in both web [5] and desktop [3, 6] applications.
We refer to this overall strategy as the baseline approach to
named widget recognition. This baseline approach has been
employed in the past by the query-feature graphs work by
Fourney et al. in [3], and by the enhanced search results work
by Ekstrand et al. in [1].

While simple and straightforward, the baseline strategy is
prone to error. Consider, for example, a tutorial describing
various options for converting a colour image to black and
white with the GIMP raster graphs software1. In the full tu-
torial, approximately 170 distinct phrases match the labels or
captions of components found in the GIMP user interface.

1http://www.gimp.org/tutorials/Color2BW/
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Figure 1. An excerpt from a tutorial describing how to convert a colour
image to black and white using GIMP 1. Substrings matching the names
of GIMP commands are outlined in rectangles. False positive matches
are crossed out.

However, upon inspection of the tutorial, only approximately
50 phrases are actual references to GIMP operations, making
the false positive rate of this approach greater than 70%. An
excerpt from this tutorial is listed in Figure 1, with all matches
outlined with rectangles and false positives crossed out.

Online documentation also often includes its own set of
menus, menu items, and controls for navigating and inter-
acting with the website. These documentation widgets can
also generate false matches when employing the baseline ap-
proach.

In the following sections, we identify a number of sources
of information that can be employed to improve upon this
baseline accuracy.

Leveraging Prior Beliefs
In the previous example, the term “desaturate” can be found
in the first sentence (Figure 1). This term is highly technical,
and rarely occurs in more general writing. Without additional
evidence, we would expect that the use of this term refers to
GIMP’s “Desaturate” command. Conversely, in the second
sentence, we encounter the term “image”. This term is very
generic, and occurs in many contexts beyond GIMP tutorials.
Without additional evidence, we assume that it represents a
false detection. Thus, by estimating how often a phrase refers
to a widget in a given corpus, it is possible to correctly label
many named widget references without any further consider-
ation of the context in which the matches occur.

Leveraging Informal Conventions
In sentence 3 of Figure 1, the term “Image” twice refers to
actual, named widgets. In such situations, further evidence is
needed to overcome the prior expectation that generic phrases
do not represent commands. This additional evidence is pro-
vided by informal conventions that are often employed in tu-
torial writing. For example, command names are often capi-
talized, and are occasionally styled to appear differently than
the surrounding text (in this case, with a bold weighting).
Special punctuation is also often employed to specify menu
hierarchies (e.g., “->” in “File->Open”). The use (or lack of
use) of these conventions can also factor into the classifica-
tion of terms.

Leveraging Page Context
Page context can provide additional evidence to help correctly
identify named widgets in cases where the online documenta-
tion contains links and website navigation with names match-
ing those of the software it is documenting (e.g., “Help”,

“About”, etc.). Specifically, matches that occur in regions
of the page that resemble site navigation reduce the confi-
dence that the matching term directly references a user inter-
face widget.

Given this foundation, we now describe a feature set and a
general classification framework that enables accurate recog-
nition of named widgets.

CLASSIFICATION FRAMEWORK
Identifying UI components referenced in web documentation
is a three step process. First, the document is examined for
substrings matching the names of known interface compo-
nents or commands (the baseline approach described above)
to yield a set of candidate matches. In the second step of the
process, a set of features is extracted from the context of ev-
ery candidate match (where the features are derived from the
cues and informal conventions discussed above). In the fi-
nal step, a classifier determines which substring matches are
indeed references to widgets.

Feature Extraction
To more correctly classify candidate named widgets, we em-
ploy the following set of features.

Capitalization
Recognizing the tendency for authors to capitalize references
to commands, our classifier employs two related capitaliza-
tion features: 1) Whether a candidate match’s first token is
capitalized, and 2) the total number of capitalized tokens
within the match sequence. For example, “Save Selection
to File” has three of its four tokens capitalized, including the
first.

Next and Previous Tokens
The next and previous tokens features record the tokens im-
mediately preceding and following the candidate named wid-
get. These features are designed to model common phrases
in which named widgets appear (e.g., “the File menu”). They
also model conventions for describing menu hierarchies, such
as the use of “>” or “->”.

Next and Previous Candidates
Given a candidate match, the next candidate and previous
candidate features record the candidate matches found before
and after the current match. All tokens occurring between
candidate matches are ignored. These features are designed
to recognize and leverage common command sequences (e.g.,
“Copy and Paste”) as well as parent-child relationships ex-
pressed in menus (e.g., “Edit > Paste As > New Layer”).

Element Occupancy Ratio and Element Type
In web-based tutorials, references to interface elements are
often expressed with some styling that makes the text visu-
ally distinct from the surrounding text. The element occu-
pancy ratio feature models these markup differences as fol-
lows. First, we identify the HTML element directly enclos-
ing the candidate match. We then compute the ratio between
the number of tokens making up the candidate and the total
number of tokens enclosed by the HTML element. For ex-
ample, the word “pencil” exhibits a 1: 4 ratio in the phrase
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“<p>Select the pencil tool</p>”, but a 1: 1
ratio in the phrase “Select the <b>pencil</b>
tool”. In addition to the element occupancy ratio, we ex-
tract a feature recording the type of the enclosing element.

Text-to-Tag Ratio and Location (wrt. the Start of the Page)
Tutorial content, and hence named widgets, often make up
the “main content” of the enclosing HTML document (as op-
posed to secondary content such as navigation, headers, and
advertisements). In the information extraction literature, the
text-to-tag ratio has been found to be a good feature for dis-
criminating between main and secondary content [8]. Specif-
ically, main content is typified by regions of the HTML doc-
ument containing many text tokens, but few HTML tags.
These regions are said to have a high text-to-tag ratio. Sim-
ilarly, main article content is often found in the central re-
gion of an HTML file, somewhere between header content
and footer content. Thus, we use the location of the match
within the HTML document to help rule out candidates that
are likely part of a tutorial’s site navigation.

Notably absent from this list of 10 features is any representa-
tion of our prior beliefs regarding the likelihood that a candi-
date match represents a named entity. Prior beliefs are those
held before considering evidence (i.e., features), and are mod-
elled by the classifier directly. We describe the classifier next.

A Naive Bayes Classifier with Witten-Bell Smoothing
The features outlined above are compatible with many mod-
ern text classification and information extraction techniques.
In this work, we elected to construct a recognizer that em-
ploys naive Bayes classification. While potentially less effec-
tive than more complex techniques (e.g., [2]), naive Bayes
classifiers have nonetheless proven to be effective general
purpose classifiers, and are certainly sufficient for demon-
strating the feasibility of named-widget recognition. More-
over, naive Bayes classifiers confer a number of unique ad-
vantages. First, the number of parameters in a naive Bayes
model scales linearly with the number of features and classes
[7]. As a result, comparatively less training data is required to
produce an effective classifier. Additionally, the “naive” in-
dependence assumption affords the ability to independently
learn the feature distributions, thus enabling efficient train-
ing in the types of distributed systems typical of existing web
indexing platforms.

In order to classify commands, we employ a separate binary
naive Bayes classifier for each UI component we would like
to recognize. When classifying a candidate match, we invoke
only the classifier corresponding to that named component.
For example, substrings matching the text “File” invoke the
classifier corresponding to the system’s File menu.

By treating commands separately rather than collectively via
a single class or classifier, we ensure that the framework is
able to directly model the subtle differences in context in
which named entities are expected to occur (e.g., enabling
the classifier to learn menu structures). Unfortunately, the
strategy aggravates the problem of sparse data, and the train-
ing data may not include mentions of every available wid-
get. To overcome the sparse data problem, we use Witten-

Bell smoothing [9]. Witten-Bell smoothing uses the train-
ing data to estimate the likelihood of novel events. It then
uses this estimate, together with a more general “backoff”
model, to redistribute probability mass, thus filling in missing
information. In our case, the backoff model is constructed by
pooling the training data for all named entities into a single
“generic widget” class. As a concrete example, suppose that
the training data does not include any examples of the “Cut”
command. With Witten-Bell smoothing, we can use what we
know about commands in general to predict how references
to the “Cut” command might appear in text.

EVALUATION
To evaluate the accuracy of the classification framework, we
trained classifiers for each of the software applications listed
in Table 1. In the following sections, we describe how the
necessary training data was collected, how the classifiers
were evaluated, and report the results of the evaluation.

Generating Training Data
In the course of conducting previous research with query-
feature graphs [3], we had previously amassed a corpus of
thousands of web documents pertaining to each of the soft-
ware applications listed in Table 1. These corpora were col-
lected using standard web crawling procedures. To generate
training data for a particular application, we randomly sam-
pled 35 documents from the associated document collection.
We then identified candidate matches within each document,
and manually labeled each as either referring to a command or
not. Since terminology varies in generality from application
to application (e.g., the names of commands in GIMP tend to
be technical), and because we sampled an equal number of
pages for each application, the number of labeled examples
in each training set differ.

Evaluation and Results
In order to measure the accuracy of the classifiers, we em-
ployed leave-one-out validation on a per-page basis: in each
round, the classifier is trained with items found in all but one
of the web documents, and is evaluated using the withheld
document. We report the results of this experiment in Table
1. To provide a point of comparison, the table also presents
the accuracy achieved when using only the baseline approach.

The results suggest that the classification framework per-
forms well. The tested classifiers are able to accurately label
an average of 93.7% of all candidate named entities, surpass-
ing the baseline accuracy by a wide margin. Viewed as a
retrieval problem, the classifier returns an average of 75% of
all actual named widgets (i.e., recall), with an average true-
positive rate of 87% (i.e., precision). This yields an overall
F1 score of 0.81.

To verify the classifiers were modelling the phenomena as
expected, we manually inspected the conditional probability
tables making up the various naive Bayes classifiers. Through
this inspection, we found that the classifiers were indeed
modelling various structural aspects of the target interface.
For example, our approach automatically learns that the most
likely token to follow a reference to GIMP’s “Fuzzy Select”
command is the word “tool”, which is expected since “Fuzzy
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GIMP Inkscape Thunderbird Total
Classifier:

True + 598 405 445 1448
False + 53 91 71 215
True - 2040 2668 4215 8923
False - 133 181 164 478

Precision 0.92 0.82 0.86 0.87
Recall 0.82 0.69 0.73 0.75
F1 score 0.87 0.75 0.79 0.81
Accuracy 93.4% 91.9% 95.2% 93.7%

Baseline:
F1 score 0.41 0.30 0.22 0.30
Accuracy 25.9% 17.5% 12.4% 17.4%

Table 1. Evaluation results characterizing the performance of the pro-
posed classification framework. For comparison, the final two rows of
the table present performance characteristics of the baseline method.

Feature Set F1 score
Next and Previous Candidate Matches 0.78
Next and Previous Tokens 0.63
Capitalization 0.63
Text-to-Tag Ratio / Location 0.59
Element Occupancy Ratio / Element Type 0.50
No features (i.e., using the prior distribution directly) 0.50

Table 2. Classification performance when using only the features named
in the leftmost column.

Select” is a tool that appears in GIMP’s toolbox. Similarly,
the words “window” or “dialog” are the most likely tokens to
follow references to GIMP’s “Channels” window.

Finally, to determine the relative importance of the various
features employed by the classifier, we re-ran the experiment
with classifiers employing various subsets of the available
features. For example, we found that classifiers employing
only the “Next and Previous Candidates” features achieve an
overall F1 score of 0.78 across the three applications. Sim-
ilarly, the classifiers utilizing only the “Capitalization” fea-
tures achieve an overall F1 score of 0.63. The difference
between these scores reflects the relative importance of the
associated features. Of all features, “Element Occupancy Ra-
tio” and “Element Type” were the least effective (F1 score of
0.50), providing less inferential leverage than we would have
liked. A summary of the F1 scores for the various feature sets
is listed in Table 2.

DISCUSSION AND FUTURE WORK
In this paper, we have demonstrated a system that draws
upon informal practices in tutorial writing to detect refer-
ences to named widgets in online documentation. The re-
sulting named widget recognizer provides the foundation for
a number of new interaction possibilities, including: (1) new
means of indexing and searching tutorials, (2) the ability for
users to invoke commands directly from within tutorial text,
(3) the creation of summaries that highlight important steps
in long tutorials (i.e., generating “Quick Start” guides), and
(4) the automatic generation of macros or macro templates.

As with any complex system, there are a number of limita-
tions of our recognizer worthy of further discussion.

First, our recognizer compares online documentation against
a list of known widgets, and disambiguates between meaning-
ful references and spurious/coincidental string matches. Our
recognizer is both trained and evaluated using automatically
generated lists of all strings in a user interface (e.g., captions,
labels, tooltips, etc.). A limitation of this approach is that it
does not consider cases where online documentation refers to
a widget using alternative text (e.g. “click the ‘No’ button”
when the button is actually labeled “Cancel”). Consideration
of such novel synonyms can be expected to lower the recall
scores as compared to the results reported in Table 1. This sit-
uation can be partially ameliorated by adding common syn-
onyms to the list of widget names, but a more general solution
for detecting novel synonyms remains a topic of future work.

Additionally, our system cannot disambiguate between dis-
tinct widgets that share a common name. For instance, in
the GIMP 2.6 interface, both a menu and a panel share the
caption “Layers”. Fortunately, this does not significantly im-
pact the applicability of the proposed technique to applica-
tions such as improved tutorial indexing or tutorial summa-
rization. Moreover, we can often rely on the user to differen-
tiate between multiple possible interpretations. In the future,
we hope to leverage additional context to automatically dis-
ambiguate between identically named widgets.

Despite the aforementioned considerations, the proposed rec-
ognizer can be immediately applied to existing research, in-
cluding query-feature graphs [3], the work of Lau et al. [4],
and the work of Ekstrand et al. [1].
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